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What's New 1

1 What's New

New features in ODBC Driver for SendGrid 1.1

¢ Fixed connection timeout setting before opening connection

¢ Now keys and passwords are stored in an encrypted form in the DSN record

New features in ODBC Driver for SendGrid 1.0

e |nitial release of ODBC Driver for SendGrid
e Windows 32-bit is supported
e Windows 64-bit is supported

© 2015-2024
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2 General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support
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2.1 Overview

Overview

Devart ODBC Driver for SendGrid is a high-performance connectivity security with enterprise-
level features for accessing SendGrid from ODBC-compliant reporting, analytics, Bl, and ETL
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tools on both 32-bit and 64-bit Windows. Our ODBC driver fully supports standard ODBC API
functions and data types and enables easy and secure access to live SendGrid data from

anywhere.

/ ODBC API |_—||:‘_‘\

o

+/ ODBC Data Types ‘L
[ |

Connection to SendGrid

Our data connector enables various ODBC-aware applications to connect to SendGrid
directly via HTTPS. If you have no direct access to SendGrid via HTTPS, you have the option
of establishing a connection through a proxy server.

Application

HTTPS
ODBC Interface

Driver Manager Proxy

SendGrid

Devart ODBC Driver Cloud
for SendGrid

© 2015-2024
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2.2

Features

Application

.

SendGrid

0DBC Interface

Driver Manager Proxy

Devart ODBC Driver
for SendGrid

Extended SQL Syntax

Our ODBC driver provides an unrivalled
opportunity to work with SendGrid objects
just as with SQL tables. The extended SQL
syntax allows you to use all the SQL
benefits in SQL-92 compatible SELECT

statements:

* Complex JOINs

¢ WHERE conditions

® Subqueries

®* GROUP statements

* Aggregation functions
* ORDER statements

® and more.

Connection to SendGrid

Our connectivity solution enables various
ODBC-aware applications to connect to
SendGrid directly via HTTPS. If you have
no direct access to SendGrid, you have the
option of establishing a connection through

a proxy server.

select
c.FirstName,
c.MailingCountry,
c.MailingStreet,
c.MobilePhone,
a.Accountiumber
from
{select
FirstName,
MailingCountry,
MailingStreet,
MobilePhone,
AccountId
from
Contact
where
MailingCountry = "USA') ¢
left join Account a
on c.AccountId = a.Id
where

a.Rating in ("Warm', "Hot')

© 2024 Enter your company name
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DML Operations Bulk Updates
Devart ODBC Driver for SendGrid Moreover, with our driver you can perform
provides support for DML (INSERT, bulk updates to SendGrid by combining

UPDATE, DELETE) operations, which SQL statements into batches, thus
allows you to modify data in SendGrid in  |simplifying and speeding up large data

the same way as in SQL databases. modification with SendGrid.

ODBC Conformance

The driver provides full support for common
ODBC interface:

e ODBC APIFunctions support g € \

= o
U

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to SendGrid from
various environments and platforms, that
support ODBC.

© 2024 Enter your company name
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+" SendGrid API

+/ SendGrid Data Types

Advanced Data Conversion

We have implemented advanced Data

Conversion mechanisms that provide bi-

SendGrid Compatibility

Our ODBC driver fully supports all data
types defined in the SendGrid APL.
Moreover, the driver is compatible with the
SendGrid APl itself.

Integration

The driver is compatible with 3rd-party data
analysis tools, such as Microsoft Excel, and

integrates with various IDEs and systems

directional mapping between any SendGrid|like Visual Studio, etc.

and ODBC data types.

Platforms Variety

Devart ODBC Driver for SendGrid can be
used with 32-bit and 64-bit applications on
both x32 and x64 platforms, so there is no
need to additionally configure the driver,

applications or environment.

High Performance

For a complete list of compatible tools and

platforms, see Compatibility.

Fully Unicode Driver

With our fully Unicode driver, you can
retrieve and work with any data from muilti-
lingual SendGrid databases correctly, not
depending on whether its charset is Latin,
Cyrillic, Hebrew, Chinese, etc., in any

environment localization.

Support

© 2024 Enter your company name
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2.3

Every operation with SendGrid becomes o )

Visit our Support page to get instant help
significantly faster using such capabilities .

from knowledgeable and experienced
of our driver as Local data caching, _ _ _

professionals, a quick resolution of your
connection pooling, query optimization and . . .

problems, and nightly builds with hotfixes.
much more.

© 2015-2024
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Compatibility

SendGrid Compatibility

SendGrid API v

SendGrid Data Types v

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)
e Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion
Embarcadero Delphi & C++Builder

FileMaker

CIS 1SS

Lazarus
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Microsoft Visual FoxPro

Microsoft Visual Studio
Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

CICC S

Python

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CICOIC SO K

SQL Server Reporting Services

Bl & Analytics Software

Alteryx

<

DBxtra

<

Dundas Bl v
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FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

TIBCO Spotffire

CICIC SIS

Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

StarOffice

CIL LS

© 2015-2024
Devart. All Rights
Reserved.

Request Support

ODBC Forum

Provide Feedback
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2.4 Requirements

The following requirements must be met for ODBC Driver for SendGrid:

¢ Only one version of ODBC Driver for SendGrid is installed on your system.

e NET Framework 4.5 or later is installed on your system.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

2.5 Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop

© 2024 Enter your company name
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computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

© 2024 Enter your company name
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- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written

© 2024 Enter your company name
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permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems

© 2024 Enter your company name
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will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.
© 2015-2024
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26 Getting Support

This document lists several ways you can find help with using ODBC Driver for SendGrid
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
SendGirid:

¢ You can find out more about ODBC Driver for SendGrid installation or licensing by

consulting Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

¢ You can get advanced technical assistance by ODBC Driver for SendGrid developers

through the ODBC Driver for SendGrid Priority Support program.

Subscriptions

The ODBC Driver for SendGrid Subscription program is an annual maintenance and support
service for ODBC Driver for SendGrid users.
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Users with a valid ODBC Driver for SendGrid Subscription get the following benefits:
¢ Product support through the ODBC Driver for SendGrid Priority Support program

e Access to new versions of ODBC Driver for SendGrid when they are released
¢ Access to all ODBC Driver for SendGrid updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for SendGrid Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for SendGrid-related questions from the
ODBC Driver for SendGrid developers themselves. Priority Support is carried out over email
and has a two business day response policy. Priority Support is available for users with an
active ODBC Driver for SendGrid Subscription.

To get help through the ODBC Driver for SendGrid Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for SendGrid Registration number.

e Full ODBC Driver for SendGrid edition name and version number. You can find the version
number in DLL version information.

¢ Versions of the SendGrid server and client you are using.

e A detailed problem description.

e [f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for SendGrid.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
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Reserved.

Using ODBC Driver

© 2024 Enter your company name


mailto:odbc@devart.com
mailto:sales@devart.com
https://www.devart.com/company/contactform.html?category=0&product=odbc/sendgrid
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/sendgrid/feedback.html

Using ODBC Driver 15

1. Installation

. Connecting to SendGrid

. Connection String Parameters

. Sandboxed Apps on macOS
. Using with iODBC
. Enabling ODBC Tracing

. Supported Data Types
. Supported ODBC API Functions
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3.1 Installation

ODBC Driver for SendGrid currently supports Windows 32-bit and 64-bit.

e Regular Installation

¢ Silent Installation

© 2015-2024
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3.1.1  Windows

Installation on Windows

1. Download and run installer executive file.

2. Follow the instructions in the wizard.
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EEJ Setup - Devart ODBC Dnver for SendGrid — X

Welcome to the Devart ODBC Driver for
SendGrid Setup Wizard

This will install Devart ODBC Driver for SendGrid 1.0.0 on your
computer.

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, ar Cancel to exit Setup.

WARMIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for SendGrid

3. In case you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the

driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.

© 2024 Enter your company name
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ﬁ:@ Setup - Devart ODBC Dnver for SendGrid = 4

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue,

Full installation v
ﬂ Devart QDBC Driver for SendGrid 45, 7MB
ﬂ Driver for Win32 16,0 MB
ﬂ Driver for Wing4 29,5 MB
B Help and Manual 2,4MB

Current selection reguires at least 50,4 MB of disk space.
< Back Cancel

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.

© 2024 Enter your company name
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm

4 Downlo

D Music v < >

1item =
8. Click Next.

9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.
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3.1.2 Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCSendGrid.exe /SILENT /ActivationkKey=ylc7nmgdu234TaszxcvONGurjfhxm9
DevartODBCSendGrid.exe /VERYSILENT /ActivationkKey=ekhdh765mh09ukr237gfHRtril
Note: The installation is performed by entering a license key.

DevartODBCSendGrid.exe /SILENT /ActivationFile=d:\1lic.key
DevartODBCSendGrid.exe /VERYSILENT /ActivationFile=d:\1lic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

© 2015-2024
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3.2 Product Activation

¢ Obtaining Activation Key

e Activation on Windows

¢ Where to see the license information

© 2015-2024
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3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
account.

4. To login to the Customer Portal, use your Username and Password from the registration
email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

Activation Key

ulw7jCODENGAEDFgbNZjuTATODWgLMNmD{ Meuy-+kt2YiSV39cp39ihBaIZ6mCh
fsILhFJgrehQWxTEmuz LIi+I0ycFEPkmX+Z5Y QP XiTebxgMUSHsUdPVskis
ImgHBa WSSO XuKKBzPIxDI81to5#5vmpp|LEEXvIaOkPRhdaraau3 UK

.....

COPY TO CLIPEQARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows
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3.2.2 Activation on Windows

Driver Activation After Installation
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To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

Data Sources

(ODBC)

2. In the System DSN tab click the Add button.

; ODBC Data Source Administrator (4-bit)

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QDB Driver for BigCommerce_x32  32-bit Devart OQDBC Driver for BigCor Remave
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QDBC Driver for MailChimp_x32 J2-bit Devart QDBC Driver for MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QODBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySGQ1 Y
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apphy Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key >

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key... QK Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.

© 2015-2024
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3.2.3 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources
(QODBC)

2. Open the System DSN tab and click the Add button
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System Data Sources:

E ODBC Data Source Administrator (4-bit)

Mame

QODBC Driver for Azure_x32

QODBC Driver for BigCommerce_x32
QDBC Driver for Dynamics_32
QDBC Driver for Firebird_x32
QDBC Driver for Magento_x32
QODBC Driver for MailChimp_x32
QDBC Driver for MangoDB

QDBC Driver for MangoDB_x32

QDBC Driver for MySQL 32bit
£

Platfarm
32-bit
32-bit
32-bit
32-bit
32-bit
32-bit
G4-bit
32-bit
32-bit

Diriver

Devart QDBC Driverfor SAL 5
Devart QDBC Driver for BigCor
Devart QDBC Driver far Dynam
Devart QDBC Driver for Firebirc
Devart QDBC Driver for Mager
Devart QDBC Driver for MailCh
Devart QDBC Driver far Mongao
Devart QDBC Driver far Mongao

Devart ODBC Driver for MySQI ¥
>

B

Cancel

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

Add...

Remove

Configure...

Apply

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab
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General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . Ok Cancel

See also
e Product Activation

© 2015-2024
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3.3 Connecting to SendGrid

This section describes how to connect to SendGrid using ODBC Driver for SendGrid

1. Driver Configuration

2. How to Get API Key

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/sendgrid
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/sendgrid/feedback.html
https://www.devart.com/company/contactform.html?category=0&product=odbc/sendgrid
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/sendgrid/feedback.html

28 ODBC Driver for SendGrid

3.3.1  Connecting to SendGrid

Windows DSN Configuration

To connect to SendGrid you need to have an APl key. Please refer to the following
documentation on how get the API key. After installing the driver, create a DSN for
Freshservice in the ODBC Data Source Administrator.

1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for Freshservice and click Finish. The driver setup dialog
will open.

5. Enter the connection information in the appropriate fields.
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JBL. Uriver for >endGnd Lonnguration

General Advanced Settings License  About

Data Source Mame Dewvart ODBC Driver for SendGrid

Description

APT Key resssesssssenssssnvenss [0 Save APIKey

Proxy Server Port 0

| Proxy User ID

Proxy Password [|save Password

Test Connection . Cancel

See Also
Connection Options
© 2015-2024
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3.3.2 How to Get APl Key

How to get APl Key for ODBC Driver for SendGrid

1. Sign up or sign in into your SendGrid account on the website.

2. Go to theSettings section of the dashboard.
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Settings v

3. In the Settings section, go to API Keys page.

1 Settings V

4. If there are no APl Keys, create a new one using the following button:

APIKeys

&

Get started creating APl Keys

APl keys help p

account (2.9 contacts and aceount settings). To control and

users, you can create multiple API keys, each with different permissions.

5. Enter APl Key name and select the appropriate permission level. We recommend creating
an AP| Key with Full Access
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Create API Key

APl Key Name

API Key Permissions® (L

Full Access

Allows the APl key to a
billing and Email Addre

SET, PATCH, PUT, DELETE, and POST endpoints for all parts of your account, excluding
alidation.

Restricted Access

“

e}
Customize levels of access for all parts of your account, excluding billing and Email Address Validation.
Billing Access

“3

m

Allows the APl key to access billing endpoints for the account. (This is especially useful for Enterprise or Partner
customers looking for more advanced account management.)

6. Copy your APl Key and use for connection creation. Please note, that for security

reasons, SendGrid shows the APl Key only once

o

API Key Created

Please copy this key and save it somewhere safe

For security reasons, we cannot show it to you again

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
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3.4

Connection String Parameters

SendGrid ODBC Connection String Parameters

The following table lists the connection string parameters for ODBC Driver for SendGrid.

Paramet
er

APIKey

Description

The APl key allows authorization of a specific application to access

SendGrid data. To save your APl key in the DSN settings, select the Save

API key checkbox.

Advanced Settings

Allow NULL
strings
Empty
strings as
NULL

Connection

Timeout

ODBC

Behavior

To retrieve metadata, not all parameters according to MSDN can accept a
null value. If NULL, the driver should return an error. But some 3rd-party
tools pass NULL to the parameters. These options should be enabled for

compatibility with such tools.

The time (in seconds) to wait for a connection to open before terminating

an attempt. The default value is 60.

Used to set the behavior corresponding to the ODBC specification
version that a third-party tool expects. The behavior of ODBC driver can
be changed by setting a value for the SQL_ATTR_ODBC_VERSION
attribute by calling the SQLSetEnvAttr function. But some third-party tools
expect the driver to exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the specified version or pass an incorrect value there.
In this case, the required behavior can be explicitly specified in the
Connection String by setting the ODBC Behavior parameter. The possible

values are:

® Default - default ODBC behavior determined by a third-party tool.
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* VVer 2.x- ODBC 2.x behavior is explicitly set.
* Ver 3.x- ODBC 3.x behavior is explicitly set.

RegionalNu ) ) ,
Enables the use of local regional settings when converting numbers to

mberSetting|
strings.

S

RegionalDat

Enables the use of local regional settings when converting dates and

eTimeSettin| .
times to strings.
gs

Use the option to specify whether the driver must return foreign keys.

Retrieving metadata about foreign key constraints is a time-consuming
ReturnForei |operation; many third-party tools request foreign key metadata even whey
gnKeys they do not actually need this information. Note that enabling the

parameter may degrade performance of data access operations. The

default value is False.

Sets the string value types returned by the driver as Default, Ansi or

Unicode.

® Default - the driver defines the string types.

* Ansi - all string types will be returned as SQL_CHAR, SQL_VARCHAR
String Types, and SQL_LONGVARCHAR.
* Unicode - all string types will be returned as SQL_WCHAR,
SQL_WVARCHAR and SQL_WLONGVARCHAR.
The parameter value should be changed if any third-party tool supports
only Ansi string types or Unicode ones.

Custom .
Allows accessing custom table fields.
Fields
QueryTimeo The time to wait for a query execution result before terminating and
ut generating an error.

UTC Dates |Specifies whether all the datetime values retrieved from the data source
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3.5

are returned as UTC values or converted to local time and whether the
date values specified on the application side (e.g., in SQL statements) are

considered UTC or local. The default value is false.

ODBC Driver for SendGrid Connection String sample

DRIVER=Devart ODBC Driver for SendGrid;API Key=yourapikey

© 2015-2024
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Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type obBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open control Panel > Administrative Tools) and choose the application of the needed

bitness.

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the

application, then click App1ly.
. Click start Tracing Now.
. Restart all application processes.

. Click Test connection in the DSN settings to make sure the driver is able to connect.

N o o M

. Reproduce the issue.
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8. Click stop Tracing Now on the Tracing tab.

9. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.

3. If necessary, change the default Log file path.

4. Select A1l the time inthe when to trace option.

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:
[oDBC(C]

Trace=Yes
TraceFile=/home/test/devart.log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

© 2015-2024
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3.6 Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for SendGrid supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
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Obtains an
environment,
SQLAllocHandle vf ISO 92 connection,
statement, or
descriptor handle.
Connects to a
specific driver by
SQLConnect v, ISO 92 data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
SQLDriverConnect v, ODBC requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
SQLAllocEnv ' Deprecated environment handle
allocated from driver.
Obtains a

SQLAllocConnect ' Deprecated
connection handle

ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose

Returns the list of
SQLDataSources v ISO 92 ilable dat
available data
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sources, handled by

the Driver Manager

Returns the list of

installed drivers and
SQLDrivers ' ODBC their attributes,

handles by Driver

Manager

Returns information
SQLGetinfo y SO 92 abouta specific

driver and data

source.

Returns the functions
SQLGetFunctions v, ISO 92 supported by the

driver.

Returns information

SQLGetTypelnfo v, ISO 92 about supported
data types.

ODBC API Calls for Setting and Retrieving Driver

Attributes
Function Name Support Standard Purpose

Sets a connection
SQLSetConnectAttr v, ISO 92

attribute.

Returns the value of
SQLGetConnectAttr v, ISO 92 a connection

attribute.
SQLSetConnectOpti Sets a connection

v Deprecated .

on option
SQLGetConnectOpti v, Deprecated Returns the value of
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on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

Deprecated

a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

SQLBindParameter

SQLGetCursorNam

e

Standard

Deprecated

ISO 92

ODBC

ISO 92

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later
execution.

Assigns storage for
a parameterinan
SQL statement.
Returns the cursor
name associated
with a statement

handle.
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SQLSetCursorNam Specifies a cursor

v, ISO 92
e name.

. Sets options that

SQLSetScrollOption

v, ODBC control cursor
s

behavior.

ODBC API Calls for Submitting Requests

Function Name Support Standard Purpose

Executes a prepared
SQLExecute v ISO 92

statement.

Executes a

SQLExecDirect ' ISO 92 t
statement

Returns the text of an
_ SQL statement as
SQLNativeSq| v ODBC
translated by the
driver.
Returns the
. description for a
SQLDescribeParam ' ODBC
specific parameter
in a statement.
Returns the number
SQLNumParams v, ISO 92 of parameters ina
statement.
Used in conjunction
with SQLPutData to
supply parameter
SQLParamData v, ISO 92 PPYP
data at execution
time. (Useful for long

data values.)
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Sends part or all of a

data value for a
SQLPutData v, ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
Returns the number
of rows affected by
SQLRowCount v ISO 92
aninsert, update, or
delete request.

Returns the number
SQLNumResultCols .\/ ISO 92 of columns in the

result set.

) Describes a column
SQLDescribeCol v ISO 92

in the result set.
Describes attributes
SQLColAttribute .\/ ISO 92 of a columnin the
result set.
Describes attributes
SQLColAttributes v Deprecated of a columniin the
result set.

Returns multiple
SQLFetch v, ISO 92

result rows.

Returns scrollable
SQLFetchScroll v ISO 92

result rows.

Returns scrollable
SQLExtendedFetch v Deprecated

result rows.
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SQLSetPos

SQLBulkOperations

ODBC

ODBC

Positions a cursor
within a fetched
block of data and
enables an
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
bookmark
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic

Information

Function Name

SQLError

SQLGetDiagField

SQLGetDiagRec

Support

Standard

Deprecated

ISO 92

ISO 92

Purpose
Returns additional

error or status
information

Returns additional
diagnostic
information (a single
field of the
diagnostic data

structure).

Returns additional

diagnostic
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information (multiple
fields of the
diagnostic data

structure).

ODBC API Calls for Obtaining Information About

Database Objects (Catalog Functions)

Function Name

SQLColumnPrivileg

es

SQLColumns

SQLForeignKeys

SQLPrimaryKeys

SQLProcedureColu

mns

Standard

ODBC

X/Open

ODBC

ODBC

ODBC

Purpose
Returns a list of

columns and
associated
privileges for one or
more tables.
Returns the list of
column names in
specified tables.
Returns a list of
column names that
make up foreign
keys, if they exist for
a specified table.
Returns the list of
column names that
make up the primary

key for a table.

Returns the list of
input and output
parameters, as well

as the columns that
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constitute the result
set for the specified
procedures.
Returns the list of
SQLProcedures v OoDBC procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
SQLSpecialColumn table, or the columns
,/ X/Open
s that are
automatically
updated when any
value inthe row is
updated by a
transaction.
Returns statistics
about a single table
SQL Statistics ' ISO 92 and the list of
indexes associated
with the table.
Returns a list of
tables and the
SQLTablePrivileges v ODBC privileges
associated with

each table.
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Returns the list of

table names stored
SQLTables ' X/Open

in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

Commits or rolls
SQL Transact V' Deprecated .
back a transaction

Commits or rolls
SQLENndTran v ISO 92
back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees alll
resources
associated with the

statement handle.

Closes a cursor that

SQLCloseCursor ' ISO 92 has been opened on
a statement handle.
Cancels an SQL
SQLCancel W, ISO 92
statement.

ODBC API Calls for Terminating a Connection

Function Name Support Standard Purpose
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. Closes the
SQLDisconnect v ISO 92
connection.
Releases an
environment,
SQLFreeHandle ' ISO 92 connection,
statement, or
descriptor handle.
Releases connection
SQLFreeConnect v Deprecated
handle.
Releases an
SQLFreeEnv v Deprecated
environment handle.
© 2015-2024
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4 Using in Third-Party Tools

This section discusses how to use ODBC Driver for SendGrid with ODBC-compliant tools.

e DBeaver

e Oracle Database Link

e Microsoft Access

e Microsoft Excel

e OpenOffice and LibreOffice

* PHP
e Power Bl
* Python

¢ QlikView

e SQL Server Management Studio

e SSIS
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4.1

e Tableau
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Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

Using in DBeaver

DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing
e SQL scripts management

e Data export/import

e Data backup

e DDL generation

e ER diagrams rendering

¢ Test data generation

e BLOB/CLOB support

e Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from SendGrid via the Open Database Connectivity driver.
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Creating an ODBC Data Source to Use SendGrid Data
in DBeaver

1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system
or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for SendGrid in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for SendGrid with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR.
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Devart ODBC Driver Configuration
General Advanced settings  |icense About
Meta Data
- - - - -
Connection
-
L
Compatibility
ODBC Behavior Default hd
String Types Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONE
Use Local Regional Settings when converting to string
[ ] Mumbers [ ]Dates and times
Test Connection

Connecting to SendGrid Data from DBeaver via ODBC

Driver for SendGrid

Follow the steps below to establish a connection to SendGrid in DBeaver.

1. In the Database menu, select New Database Connection.
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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& stabase O
Generic JDBC Connection Settings
. : = 0DBC
ODBC connection settings
General Driver properties SSH Proxy
JDBEC URL: ‘jdbc:Odbc:DBEAVER_DATASOURCE
Database/Schema: | DBEAVER_DATASOURCE |
User name: ‘ |
Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing SendGrid Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all
the tables in SendGrid database. To view and edit the data in a table, you need to right-click
on the target table name and select View data.The content of the table will be displayed in the
main workspace.

ry DBeaver 6.1.5 - Solution
File Edit Mavigate Search SOLEditor Database Window Help
¢~ Ve |05 Tl ato |-

{= Databa.. 2 |[E@Projecs = O BB solution &2

- = = ¥ . .
A | = F® properties | [} Data | 57 ER Diagram = ODB
Enter a part of table name here ~

FB siteDetail A | |BBsolution |vy
AR SiteFeed T solutionMame T3+ IsPublished
B SiteHistory I - —
B Sitelf rbwh't st i 1 GC1020 Portable Generator Switch Malfunctioning true

itelframeWhiteListUr] — : .
m Soluti 2 Generator assembly instructions unclear false

olution —
M Solufionfesd % 3 Maintenance guidelines for generator unclear false
M SolutionHistory [; 4 | Selecting the Right Generator for Your Meeds true
EP Solutionstatus T s GC3000 Series Propane Generator Ignition true
B Stamp & | Starting generator after electrical failure false
BB StampAssignment 7 | Electrical wiring installation for GC5060 false
P StaticResaurce g GenWatt SLA Commitments true

If you want to write a custom SQL query that will include only the necessary columns from the
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table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

= Databa.. 2 Projects = O | [T *<0DBC > Script-5 &3
“_ e | - = b SELECT SolutionMame, SolutionNote FROM Solution;
Enter a part of table name here b,
BB SiteDetail ~ eT
FB SiteFeed = e
BB siteHistory B solution &2
B sitelframeWhiteListUrl :
E «T SELECT SolutionMame, Solt | &4
FH solution
FE SolutionFeed = SolutionMame [ SolutionNote
= = (] - -
A8 SolutionHistory | | If the generator switch i:
B8 SolutionStatus 2 | Generator assembly instructions unclear  The Maintenance Manu:
EB Stamp % 3 | Maintenance guidelines for generator uncle The Maintenance Manu:
- = — . . .
£8 StampAssignment . 4 | Selecting the Right Generator for Your Nee GenWatt offers a wide r
= StatlcR§source T s GC3000 Series Propane Generator Ignition The GC3000 series prog
: Stream!ngchannel & | Starting generator after electrical failure  After an electical failure,
= Stt;earr:ng.channelshare 7 | Electrical wiring installation for GC5060 The red wiring from the
TabDefinition — . .
i g GenWatt SLA Commitments GenWatt offers four diff
FB TabledVerify_ChangeEve — . .
( N = Electronic panel fitting loose On the GC3020, the elec
© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/sendgrid
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/sendgrid/feedback.html

52

ODBC Driver for SendGrid

Configure the Initialization File

After installing the gateway and the ODBC driver for SendGrid, create an initialization file for

your Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initSendGrid.ora. You need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNecT_1INFo parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=SendGrid

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orAcLE_HoME \NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = Tocalhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_Name) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=

(SID_NAME=SendGrid)

(ORACLE_HOME=D: \ORACLE_HOME)

(PROGRAM=dg4odbc)

)
)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the
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listener.ora file.

SendGrid =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = 1oca1host) (PORT = 1521))
(CONNECT_DATA =
(SID = SendGrid)

)
(HS = 0OK)

Create Database Links

To access an ODBC data source, you must create a database link using a database tool like

SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the

CREATE DATABASE LINK statement, as follows:

CREATE DATABASE LINK dblink CONNECT TO "username" IDENTIFIED BY "password"

dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.

When you create the database link in dbForge Studio for Oracle, you can see your newly

created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:

SELECT * FROM table_name@"dblink_name"

See also

Configuring Oracle Database Gateway for ODBC
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4.3 Usingin DBxtra

Troubleshooting SendGrid ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to SendGrid in DBxtra.

Due to incompatibilities between DBxtra and SendGrid, leaving the sqL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 or ANSI sqQL/20e3 for DBxtra version 11.0.1 or newer, and to ANSI
sqL/2ee3 for versions prior to 11.0.1.
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Connect through ODBC E3
MNOTE:
Imiportant!
Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.
Please be sure to select the right SQL dialect for your connection.
Connection name |MyData
Data source |DataSource 1 III
User
Password
Connection timeout 15 : S0L dialect || M5 Access 20000 |w
Enable Offline Mode
Get columns descriptions
Select User Groups who can view this Connection
] accounting A
[]contraling
Guest Group
[~ILegal
Management
[#IManufacturing
[#Marketing
[Purchasing W
Select Al Unselect Al Cancel
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44 Using in Microsoft Access

Connecting Microsoft Access to SendGrid Using an
ODBC Driver

This article explains how to connect Microsoft Access to SendGrid through the standard
ODBC interface. Microsoft Access is a dababase management system that combines the
relational database engine with a graphical user interface. Access can be used as a
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substitution for spreadsheet applications like Excel to organize, store, and retrieve large
amounts of related data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your SendGrid data either by importing it or creating
a table that links to the data. Devart ODBC drivers support all modern versions of Access. It
is assumed that you have already installed and configured a DSN for ODBC driver for
SendGrid. For the purpose of this article, we tested an ODBC connection to SendGrid
through our ODBC drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft
Access 2010, Microsoft Access 2013, Microsoft Access 2016, Microsoft Access 2019. The
following steps describe how to use Microsoft Access 2019 to import or link to your data in
SendGrid.

Importing SendGrid Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for SendGrid and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.
9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to SendGrid Data in Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.
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4.5

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for SendGrid and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the SendGrid table as the unique record identifier. You are
linking multiple tables, you will be prompted to select unique record identifiers for each of
the selected tables.

9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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Using in Microsoft Excel

Connecting to SendGrid from Microsoft Excel using
ODBC Driver for SendGrid

You can use Microsoft Excel to access data from a SendGrid database using ODBC
connector. With ODBC Driver, you can import the data directly into an Excel Spreadsheet
and present it as a table. Make sure that you use matching Excel and ODBC Diriver, e.qg. if
you have installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to SendGrid with Get & Transform (Power Query)
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e Connecting Excel to SendGrid with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to SendGrid with the Query Wizard

e Connecting Excel to SendGrid with Microsoft Query

e Connecting Excel to SendGrid with PowerPivot

Connecting Excel to SendGrid with Get & Transform
(Power Query)

You can use Get & Transform (Power Query) to connect to SendGrid from Excel with ODBC.
This method assumes that you've installed an ODBC driver for SendGrid.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other

Sources > From ODBC.

H s Bookl - Excel Evgeniy Lemeshov 2| |
File Home Insert Page Layout Formulas Review View Hel ¢ Tell me ,5:-."5. Share
ge Lay P
(& [& |_ e A [Z1A ~ [E Be g g
= rEED A
=1 [ - ]
Get Refresh z| Sort Filter Text to What-f Forecast Outline
= ! Y B - @ :
Data - All - i Columns =2 Analysis = Sheet M
G Sort & Filter Data Tools Forecast ~
ﬁ From File L
c b
From Database L ~ - - - e ' ; =
— 1 »
R ™ m - | + 100%
= am From Azure 4 From Table/Range
L=y
rom Jnline >ervices rom Yy e
_E) F Online Servi » _@ F Web
B =
_.¢. From Qther Sources L4 _ From Microsoft Query
N
E Combine Queries 4 _.¢. From QDBC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the
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credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

From ODBC

Data source name (DSN)

| Devart ODBC Dniver b

4 Advanced options
Connection string (non-credential properties) (optional) &

501 statement (optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (optional)
(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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ODBC driver X
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an ODEBC driver,

Windows

User name
Database myusername

Password

SR NeREeE

Credential connection string properties (optional) (0

Back Cancel

If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom ¢'d5”: evart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (O
Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.

© 2024 Enter your company name



ODBC Driver for SendGrid

O X
Navigator
yel

Select multiple items
Display Options ~ Dﬂ
4 F ODBC (dsn=0DBC Driver for 5... A

] AcceptedEventRelation . .

? No item selected for preview

B Account

B AccountChangeEvent

B AccountCleaninfo

B AccountContactRole

B AccountContactRoleChange...
Select Related Tables load |~ Edit Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.

H ©- Book1 - Excel Table... = = = x

File Home | Insert | Page La| Formul: | Data | Review | View | Design |  Tell me.. Evgeniy.. S Share
g g genty.

Al - f;r w
D E F G H -

1N SolutionName ﬂ IsPuhIishEdn IsPuhIisI’ﬂ Status ﬂ IsReuiewedﬂ §

2 |GC1020 Portable Generator Switch Malfunctioning 1 0 Reviewed 11

3 |Generator assembly instructions unclear 1] 0 Draft [

4 |Maintenance guidelines for generator unclear 1] 0 Draft 0T

5 |Selecting the Right Generator for Your Needs 1 0 Reviewed 1/d

6 |GC3000 Series Propane Generator Ignition 1 0 Reviewed 1T

7 |Starting generator after electrical failure 1] 0 Draft o n

8 |Electrical wiring installation for GC5060 1] 0 Draft 0T

9 |GenWatt SLA Commitments 1 0 Reviewed 1/

10 |Electronic panel fitting loose 0 0 Draft 0 C

Sheet1 ) 1 »

Connecting Excel to SendGrid with Data Connection
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Wizard (Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has

already been defined.

1.

In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.

. In the opened dialog, select ODBC DSN and click Next to continue.
. Now select a data source you want to connect to, and click Next.

. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to SendGrid with the Query Wizard

You can use this option to create a simple query for retrieving data from SendGrid to Excel via
ODBC driver.

1

2.

0 N O O

. Open Excel, in the main menu, click the Data tab.

Click the From Other Sources dropdown menu, and then click From Microsoft Query.

. In the appeared dialog, you can choose the data source you want to connect to.

. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.

. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.
. Select Return Data To Microsoft Excel and click Finish.

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

. The required data is successfully imported to Excel.

Connecting Excel to SendGrid with Microsoft Query
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You can use this option to create a more complex query for retrieving SendGrid data to Excel
via ODBC driver.

1.
2.
3.

Start Excel, click the Data tab.
In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC SendGrid). Uncheck Use the Query Wizard to Create/Edit

Queries and click OK.

. Now you can select the tables you want to add to your query. When you finish, just click

the Add button.

. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to SendGrid with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data

models. To load the required data, do the following:

1

. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.
. In the opened window, click From Other Sources.

2
3.
4
5

When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

. In the Specify a Connection String window, click the Build button.

. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,

using data source name - Devart ODBC SendGrid), and then click Next.

. Now you should choose how to import the data (either select a table from the list or write a

query to specify the data to be imported).

. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

© 2015-2024
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4.6

461

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to SendGrid from SQL
Server Management Studio using ODBC Driver for SendGrid.

¢ Creating a Linked Server

¢ Troubleshooting in SSMS

© 2015-2024
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Creating a Linked Server

Requirements
In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for SendGrid and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to SendGrid from SQL Server Management
Studio using ODBC Driver for SendGrid

You can use the Microsoft SQL Server Management Studio to connect your SendGrid data to
an SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as SendGrid
and merge them with your SQL Server database. You can create a linked server with one of
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these methods: by using the options in the Object Explorer or by executing stored
procedures.

Below are major advantages of using SQL Server Linked Servers to connect to SendGirid:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the

organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to SendGrid

You can follow the steps to create a linked server for SendGrid in SQL Server Management
Studio by using Object Explorer:

1. Start your Management Studio and choose your SQL Server instance.
2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers

and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.

¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for
SendGrid . Alternatively, you can input the ODBC Driver connection string in the

Provider field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access SendGrid databases through SQL Server.

Retrieving Data From SendGrid

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Object Explorer * I x
Connect~ ¥ *¥ (VI
= @ EVGEMIYL\SQLEXPRESS (SOL Server 14.0.1000 - C
Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL
wh search.CollatorDs0O

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers — O
e e IT Script « ﬂ Help
& General

Provider options:

Enable MName

U
U
[]

[Cynamic parameter
MNested queries
Level zero only
Allow inprocess

Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server
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Object Explorer
Connect~ ¥ ¥ G »

rrll-}{

= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - DATASOFT

Databases

Security

= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
# General
& Security
& Server Options b
Server type:
() 5QL Server
(®) Other data source
Pravider: Microsaft OLE DB Provider far ODBC Drivers w
Product name: | |
Data source: | |
Provider string: | |
Location | |
Catalog | |

Connechon

Now you need to input the Linked Server name, e.g. SENDGRID. In the Product Name and

Data Source fields you need to indicate the System DSN that you've previously created -

more info on System DSN setup can be found here.
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r

¥ New Linked Server - O =
Selecta page IT Scipt ~ ©) Help
& General
& Security
& Server Options Linked server: SENDGRID
Server type:
() S0 Server

© Cther data source

Provider: Microsoft OLE DB Provider for ODBC Drivers w
Product name: Devart ODBC Driver for SendGrid

Data source: SENDGRID

Provider string:

Location

Catalog

The SendGrid tables are already available to be fetched. To query the linked server, click New

Query in the toolbar:

File Edit View Project SQOL Complete Tools  Windoy
f@-O0 |- 0 -2 N BNewauery B R R
: | | P Execute
|
Object Explorer = 0 x
Connect~ ¥ ¥ G -

=] E EVGEMIYLASQOLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
.
Providers
H ORACLE
B POSTGRESGL
B sauTe

Enter your SQL query in the editor window and click Execute to run the query:
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4 SQlQueryd.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St., | Quick Launch (Ctri+Q) =S
File Edit View Query Project SOL Complete Tools Window Help
fo ol a-2 W Brevaey BRERD YT 9-C - B CmEE
© ¢ S| master < b oEeate © vESEE] R R A= Enw,
— —
Object Explorer SQLQueryé.sql - E..S.master (sa (54))* +# X
Connect~ ¥ % ¢ m -] SELECT * FROM [SURVEYMONKEY]...[ListMembers]; ==
Fs
5 AMAZON REDSHIFT ~ =
B ase
B BIGCOMMERCE
B pymnamics A
100% -
H FREBIRD
H FRESHBOOKS B Resuts [ Messages
5 INTERBASE Id Email Listld EmailType  Status CreatedDate
§ MAGENTO 1 | dac10@devat.com  2c7aBbdbef  Text Subscribed 2018-12-24 10:44:18.0000
= B SURVEYMONMKEY 2 hello10@devart.com  2c7aBbdbef  Text Subscribed 2018-12-24 10:44:15.0000
ﬂé‘ Catalogs 3 262812045  mail10@devart.com 2c7aBbdbef  Html Subscribed 2018-12-24 10:44:15.0000
System Catalogs 4 262812053  sales10@devart.com 2ZcTalbdbef  Text Subscribed 2018-12-24 10:44:20.0000
=R d}efault e 5 262812057  test10@devart.com Zc7abbdbef  Text Unsubscribed ~ 2018-12-24 10:44:22.0000
Tables
Views
< >
v
< > 0 Query execute... | EVGENIYL\SQLEXPRESS (14.0 RTM) | sa (54) | master | 00:00:13 | 5 rows

As a result, you can see the contents of the selected table retrieved directly from the
SendGrid account you are connected to.

See also
e Troubleshooting SSMS

© 2015-2024
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Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/sendgrid
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/sendgrid/feedback.html

Using in Third-Party Tools 69

properties:

-
%. Component Services

. File Action

View Window Help

Console Root
4 . Component Services
a [ Computers
4 (& My Computer
» [ COM+ Applicatio
1 (] DCOM Config
& [ -] Running Processe
p 7] Distributed Trans:
I E Ewvent Viewer (Local)
3 f.a Services (Local)

Windows... Windows R... Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo... Windows ...  WMIPro.. WMIProvi...

¥ & & @&

Micrasoft... Microsoft.L.. MicroseftV... Microsoft..

ApplD
MMC ALY MSMDPP - MsRdpbess...
Applicati... LIZE

¥ ¥ & @

MSTTS Mahimicse.. MAP Agent Map Elevated
DecObj Cla... Service COM class
NCLUA MDFAPI netman netprofm

¥ ¥ & @

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions 4

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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MSDAINITIALIZE Properties

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[T | e——

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions

available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are

connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-

11D1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

. _ N
. Advanced Security Settings for {2206CDB0-19C1-11D1-89E0-00C04FD7AB29} S

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

You can take or assign ownership of this object f you have the required permigsions or privileges.

Current owner:

< - s i = iy et o -

Change ownerta:

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At
SRRRRRRRATY

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

oK ]| Cancel Apply

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"
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Using in OpenOffice and LibreOffice

Connecting to SendGrid from OpenOffice and
LibreOffice using ODBC Driver for SendGrid
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access SendGrid data from Open Office Base
or LibreOffice Base — desktop database management systems. Note that the Windows
version of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
SendGrid, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name
of your data source into the field, e.g. ODBC Driver for SendGrid, or you can click

Browse, double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection
3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for SendGrid and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.

© 2024 Enter your company name



78

ODBC Driver for SendGrid

= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard *

Steps Decide how to proceed after saving the database

1.5elect datab . - - "
elect database Do you want the wizard to register the database in OpenOffice?

R LB LS ® Yes, register the database for me

3.5et up user authentication _
(O Mg, do not register the database

.ESEWE and proceed
After the database file has been saved, what do you want to do?

Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

Help << Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you
want to store it.
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£ save As >
= v P » This PC » Downloads * DB v O Search DB »

Organize - Mew folder 4=z o

B This PC ~ Mame Date modified Type
-J 3D Objects 2 New Database 05.06.2019 16:43  OpenDocumetr
B Deskiop
|j_: Documents
4 Downloads
D Music
&=| Pictures
B videos
e Local Disk (C)

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

[+] Automatic file name Cancel
 Hide Folders extension

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-
click the table name.
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Mew Databasel16.odb - OpenOffice Base

File Edit View Insert Tools Window Help

E'E'l_l

81

B Create Table in Design View...
[A Use Wizard to Create Table..

‘ Description

=
ER
usres
AcceptedEventRelation 2 Nane =
Account
Forms AccountChangeEvent
AccountCleaninfo
AccountContactRole
Reports AccountContactRoleChangeEvent
'9 Solution - New Database162 - QpenOffice Base: Table Data View 5 O X
File Edit View |nsert Tools Window Help
AEEE LI EREEE R .
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote | O
[ |GC1020 Portable Generator Switch Malfunctioning ] O Reviewed ] If the generator 005!
Generator assembly instructions unclear O O Draft O The 005
Maintenance guidelines for generator unclear O O Draft O The 005!
Selecting the Right Generator for Your MNeeds ] O Reviewed ] GenWatt offers 005!
GC3000 Series Propane Generator Ignition | O Reviewed | The GC3000 005
Starting generator after electrical failure O O Draft O After an 005!
Electrical wiring installation for GC5060 O O Draft O The red wiring  005:
GenWatt SLA Commitments 1 O Reviewed =] GenWatt offers 005!
Electronic panel fitting loose O O Draft O On the GC3020, 005!
GenWatt Installation Services [ | Reviewed ] GenWatt 005:

7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View...

© 2024 Enter your company name




82 ODBC Driver for SendGrid

MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databasel6.0db : Query1 - OpenOffice Base: Query Design — O X
File Edit Miew [nsert Tools Window Help

FIEIETT I i |

2| % M- HRIRT v
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote
b |GC1020 Portable Generator Switch Malfunctioning O Reviewed If the generator |0
Generator assembly instructions unclear | O Draft | The 0
Maintenance guidelines for generator unclear l O Draft [l The ]
Selecting the Right Generator for Your Meeds O Reviewed GenWatt offers |0
GC3000 Series Propane Generator Ignition O Reviewed The GC3000 o
Starting generator after electrical failure l O Draft [l After an ]
Electrical wiring installation for GC3060 [l O Drraft [l The red wiring 0
GﬂTWatt SLA Commitments M M Reviewed M GenWatt offers |0
Record |1 [ of 10 mEle sl < >
SELECT * FROM Solution;
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

4.8 Usingin PHP

Connecting to SendGrid from PHP using ODBC Driver
for SendGrid
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PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing SendGrid via ODBC. The script connects to
SendGrid database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("'DRIVER=Devart ODBC Driver for SendGrid;A

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($RecordSet, "border=1");
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odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
© 2015-2024
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Using in Power Bl

Importing SendGrid Data into Power Bl Through an
ODBC Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as SendGrid, you can use a
corresponding ODBC driver.

This tutorial explores how to connect to SendGrid and import data into Power Bl Desktop
using an ODBC driver. It is assumed that you have already installed and configured a DSN for
ODBC driver for SendGrid.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for SendGrid

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the SendGrid data into Power Bl for analysis, select the needed table and click
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Load.
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410 Usingin Python

Installing the ODBC Driver for SendGrid

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for SendGrid. To use the ODBC driver
as a translation layer between the application and the database, you need to configure it by

following the installation instructions.

Connecting to SendGrid from Python using ODBC
Driver for SendGrid

Here’s an example to show you how to connect to SendGrid via Devart ODBC Driver in

Python. First we import the pyodbc module, then create a connection to the database, insert a
new row and read the contents of the EMP table while printing each row to the Python
interactive console. To execute the script, you can type the code directly in the interactive
console or add the code to a file with the .py extension and run the file from the command
prompt.

Step 1: Connect

import pyodbc _ _
cnxn = pyodbc.connect('DRIVER=Devart ODBC Driver for SendGrid;API Key=yourap

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.
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cursor = cnxn.cursor(Q)
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535,

Step 3: Execute query

The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnhxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:

print (row)

row = cursor.fetchone()
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Using in QlikView

Connecting to SendGrid from QlikView using ODBC
Driver for SendGrid

This tutorial describes how to connect and configure QlikView to retrieve data from SendGrid
for further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data
sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or
later.

To connect to an ODBC data source from QlikView using our driver for SendGrid, perform the
steps below:
1. Open the QlikView client application and click File > New. Close the Getting Started

wizard and open File > Edit Script (CTRL+E).
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@ qlikview x64 Personal Edition - [av1]

{ File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help

i | New ctri+N || B | | v | (2| @) 52 B K clear | @ Back @ Forward | & Lock & Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites 4
=l | save Ctrl+5
Save As.. F12

Save Link

Mail as Attachment...

1]
i]

are. as a LInk

vid viL (=100 4
2 P Ctr|+P
Print Sheet...
Source Control »
Export 4
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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V]
File Edit Insert Tab Tools Help
-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main v |23 =

[GET

@ Connect to Data Source s

User ID Pazswond

|m_l,.lid | | sesee| |

Canecel

Data Sources

Help

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
- - - Devart ODBLC Driver for bMagento
Dats  Functions Variables  Settings Dievart ODBC Ciriver for MaiChimp
. Diewart ODBC Diriver for MySEIL
Database Diata from Files | | Devart ODBC Driver far MetSuite
. Dewart ODBC Driver for Oracle

| el ~ Connect... L] Relative Faths Dievart ODBC Diriver for SOL Azure
[JUseFTP Dievart ODBC Driver for SGLite
[ Fores 32 Eit Select... Meseart ONAC Mriver bor o sce

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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@ Edit Script [QV1] — O X
| File Edit Insert Tab Tools Help
“Reload #Debug < 4 - | -l i Tabs Main w =z
Main
ODBC COHWHMECT TO .E-urueyt-!unkey; "

SELECT * FROM ListMembers;

Dala  Funcions Variables Seftings

Database Data from Files
ODBC k Connect... [ Relative Paths Table Files...
— [ Use FTR
|__| Force 32 Bit Selec... - Gk \View File..
Web Files...
Field Data...
OK Cancel Help
Sheet Properties [Main] W%

General Fields  Objects  Securty Triggers

Awvailable Fields Fields Displayed in Listboxes

Clients_lconlUd ~ Email
Clients_MName ndd =
CreatedDate
P
First Mame
Id
|pOpt
IpSignup
lsGMarkey
Language
Last Mame
LastUpdate

Limdld

< Remove

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

© 2024 Enter your company name



90

ODBC Driver for SendGrid

choose a different database from the database drop-down list. Select the necessary tables
and fields. You can retrieve date from multiple tables and fields by selecting them and
clicking Add. When you are ready with your SELECT statement, click OK. You will get
back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

@ Create Select Statement - O x
Data source Devart ODBC Driver for SurveyMonkey Connect...
Database Driver.
Owier Support...

[ atabase Tables Fields | Text Order v|
Ostonal [Fades ~| I ~
T ables Images Clients_lconld
. nterestGroupings lenks Mame
Yiews : Graupi ol .
InterestGroups CreatedD ate
WSy ne Listhembers Emal "
System Tables | ListMergeFields N
[ &liases | iate ¥ | [ Show |con for ey Fields

Scripb  Table Column:  Preview  Blabs

5QL SELECT * (®) Colurnn
FROM ListMembers; () Row
() Structured
[J Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a

table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.
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) QlikView x64 Personal Edition - [CUsersh ODBC\ Documentsh 1.gvw™]

File Edit View Selections | Layout | Settings Bookmarks Reports  Tools  Object Window  Help
RN =g | & 1| € ] AddSheet.. F? ! K Clear - | (&) Back () Forward | ()
b ote 5 t
Main
. ' ¥
id A
1 ysl \ll Remove Shee
2 1 -
= y=] 43| Select Fields...
4 A1 New Sheet Object v || [B] List Box...
5 i o
6 %1 Rearrange Sheet Objects Zi|| Statistics Box...
; #Y Adjust Off-Screen Objects El Multi Box...
9 Align/Distribute v [ Table Box..
10 T
il}l| Chart...
11 o
12 it =|| InputBox...
= 3
i; V| Current Selections Box...
15 I:I_I Button...
16 3
@ alikview x64 Personal Edition - [ChUsers\EvgeniyL\Documents\new.quw*] = O e
! File Edit View Selections Layout Settings Bookmarks Reports Tools Object  Window  Help -8 X
RN H S ZE 9 o O |l 2] 9)»&7 K Clear ~| @ Back @ Forward | (& Lock J'Unlock
Main
Bil - F
Id Email ListId EmailType Status CreatedDate
262812041 dacl0@devart.com 2c7aBbdbef Text Subscribed 24.12,2018 10:44:18
262812045 hellold@devart.com 2c7aBbdbef Text Subscribed 24.12,2018 10:44:15
262812045 maill0@devart.com 2c7a8bdbef Himl Subscribed 24.12.2018 10:44:19
262812053 sales10@devart.com 2c7a8bdbef Text Subscribed 24.12.2018 10:44:20
262812057 test10@devart.com 2c7a8bdbef Text Unsubscribed 24.12.2018 10:44:22
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for SendGrid as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
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413

an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues

to fetch data from a data source via ODBC version 3.x. To prevent any issues when using

SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the

Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data

Connection

Compatibility
QDEC Behavior

String Types

IUse Local Regional Settings when converting to string

[ Imumbers

Test Connection
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Ver 2.x

Default

Request Support

[ ]Dates and times

ODBC Forum

Using in Tableau

Provide Feedback

Importing SendGrid Data Into Tableau Through an

ODBC Connection

This article explains to establish and ODBC connection to SendGrid from Tableau Desktop.

Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
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a

nd create meaningful reports to get actionable insights. With Tableau Desktop and our suite

of ODBC drivers, you can connect to various relational and non-relational databases, both

c
1

2.
3.

© o N O O

loud and on-premise.

. Run Tableau Desktop.

On the start page, select More... in the Connect pane.

Choose Other Databases (ODBC).

. Expand the DSN drop-down list and select the DSN that you have created and configured
for SendGrid. Alternatively, if you have not created a DSN, you can choose the Driver
option and select Devart ODBC Driver for SendGrid from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in SendGrid.

. You should see the list of all tables you have access to in the connected data source.

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.
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